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New with Firmware Version 06

Many customers who use the Microdust Pro in monitoring situations require

a voltage output that can be connected to external logging devices such as

chart recorders, or to control systems. Firmware version 06 provides this

facility.

The user can select an analogue output level from either a direct voltage

output, or from an average value. The output level can be set to trigger an

audible internal alarm when the output exceeds a pre set level.
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WARNINGS !

UNDER NO CIRCUMSTANCES should this instrument be

cleaned using a solvent based cleaner.

Attempts to charge non-rechargeable cells is hazardous

and can result in damage.

This instrument incorporates an internal fast-charger

circuit suitable for recharging nickel-cadmium cells. The

charger is enabled/disabled via a switch in the battery

compartment, see Figure 11.

This instrument is delivered with re-chargeable nickel-

cadmium cells and with the CHARGER circuit ENABLED.

DISABLE the charger circuit before fitting and using

non-rechargeable cells.

DISPOSAL OF NiCd BATTERIES:

Rechargeable batteries contain CADMIUM

and must be disposed of in a safe manner. In

some countries, this may involve specialist

licensed waste disposal companies.

Used batteries MUST NEVER be disposed of

by placing in a fire or incinerator, nor must

they be punctured, crushed or otherwise

mutilated or opened up in anyway.

MICRODUST pro instruments contain no user serviceable

components. If an electrical fault is suspected the

instrument must be returned to Casella CEL Ltd for repair.

The probe contains delicate optical and electronic

components. It should not be dropped or subjected to

mechanical shock. Failure to comply will render the

warranty invalid.

The warranty DOES NOT extend to cleaning or general

servicing of the instrument.

Warnings

Cd
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GETTING STARTED

It is suggested that you prepare, calibrate and operate

your MicroDust pro following the sequence of sections in

the Operations Chapter:

Preparation,

Routine Calibration,

User Defined Calibration,

Measurement,

Logging.

For optimum accuracy, it is recommended that you

perform a user calibration to correct your instrument for

the type of dust to be measured.

Getting Started
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1. DESCRIPTION OF THE MICRODUST pro

1.1 Introduction

Airborne particulate matter

can be found in the

atmosphere in the form of

dust, smoke, fumes, pollen,

and other aerosols. Major

sources of particulate in the

urban and working

environments include

combustion, materials

processing, manufacturing,

energy generation, vehicle

engine emissions, and

construction.

Particulate matter is

responsible for reduced

visibility, the spread of

contamination, inhalation of

toxic substances and low

worker productivity. It is

also recognised as a

contributory factor to many

medical conditions

including asthma, bronchitis

and lung cancer.

Traditional gravimetric methods of dust measurement require a significant

sampling period and are not suited to the evaluation of concentration trends

in real-time. The MicroDust pro is an ideal survey instrument for the

assessment of real-time particulate concentration in mg/m
3
. It is totally

portable and suitable for both fixed site and general survey applications. From

firmware Version 06, a user selectable analogue output and alarm are

provided that can be connected to external logging devices.

Accurate and repeatable dust concentration measurement is achieved using

proven forward light scattering techniques. The MicroDust pro offers

graphical presentation of concentration trends, internal data logging as

standard, simple and clear user interface and digital calibration methods to

suit any dust sampling scenario.

The WinDust proWindows
TM

software package supplied with this

instrument has been developed to make the downloading and presentation of

data as simple as possible. In addition, it offers a PC real time display of

particle concentration with a scrolling graph.

Figure 1: The MicroDust pro
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The MicroDust pro is able to exhibit the highest degree of sensitivity for

particle sizes within the respirable domain, while the detachable probe allows

readings to be taken in relatively inaccessible areas.

The MicroDust pro offers measurement over four ranges:

¤ 0.001 to 2.500 mg/m
3

¤ 0.01 to 25.00 mg/m
3

¤ 0.1 to 250.0 mg/m
3

¤ 1 to 2500 mg/m
3

All instruments are calibrated at the factory using reference test dust (ISO

Fine 12103-1 A2, equivalent to Arizona Road Dust). These facilities allow the

calibration concentration to be determined using traceable gravimetric

analytical techniques. An optical calibration element is supplied as a reference

to confirm the factory calibration point. For optimum calibration against local

dust conditions, a sampling pump and optional gravimetric or respirable

adapter unit may be used to provide comparative analysis between

gravimetric and real time data.

The high definition liquid crystal display is capable of showing both text and

graphical information. It shows instrument configuration details, contaminant

levels, logger information and battery condition.

1.2 Principle of Operation

The instrument uses a modulated beam of infra-red light projected forward

into a measurement chamber.

Under clean air conditions all light is prevented from reaching the receiver by

a light stop. When dust particles enter the sample volume, the light beam is

scattered forward within a narrow (12 - 20
o
) angle to the receiver.

By using this narrow angle of scatter, the instrument�s sensitivity to variations

in the refractive index and colour of measured particulate is reduced.

Excellent linearity is achieved right up to 2500 mg/m
3
as shown in Figure 3.

Figure 2: The sampling probe

Infra Red
Emitter

Infra Red
Detector

Sample
Volume

Light Stop
00009
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1.3 The MicroDust pro Menu Structure

The general instrument layout is shown in Figure 4.

The operator interface is based upon a series of menu options organised as

shown on the fold out sheet at the back of this book.

A combination of function keys and navigator keys on the front panel of the

instrument are used to move around the menu system and change setup

parameters.

Figure 3: Instrument Response with ISO Fine 12103-1 A2

(Equivalent to Arizona Road Dust)
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The key functions are as follows.

and Navigator keys used to move around the
current menu options.

and Navigator keys used to change the
contents of the selected field, such as
the indicated date, time, logging interval,
etc.

Enter key that accepts the current menu
option or highlighted option.

Esc (Escape) key that steps back to a
previous menu.

Enter

Esc

Figure 4: General layout of the MicroDust pro

CASELLA

MICRODUST pro
Aerosol Monitoring System

Esc

Enter

v30053

Pull the knurled
sleeve outwards

to release the
connector

Red dot Slide the
Probe Collar
up or down to
expose the
measurement
chamber

Clip

Probe purge
inlet

Escape

ON/OFF

Navigator keys

Battery charging
indicator

Enter
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Options that are not currently available are marked �X�; for example while

the instrument is logging data, calibration cannot be performed.

Pressing several times at any point provides a short cut back to the Main

menu.

The Main menu contains all parameters and options relevant to operation and

gives access to three sub-menus.

Calibration menu Allows the instrument to be calibrated.

Configuration menu Allows the instrument parameters to be

specified.

Logger Allows the logger to be configured and

data storage to be started and stopped.

1.4 Analogue Output/RS 232 Socket

An analogue output signal is available for interfacing the MicroDust pro to a

chart recorder or external data logger. Wiring details of the analogue output/

RS 232 socket are shown in Figure 5 and Table 1.

From firmware Version 06, the user can select the output to represent either

average or raw data sources, or set a high or low alarm condition.

Esc

Figure 5:

Line identities of the Analogue/RS 232

socket, viewed externally (i.e. also from

the solder bucket side of the plug)

00018

6

4

2

5

3

1

Table 1: Line functions

Function Pin Number Wire Colour 9-way D Type

(PC RS 232)

Analogue ground 1 Yellow N/A

Analogue Out 2 Red N/A

RS 232 Receive in 3 White 3 (TX out)

RS 232 Transmit out 4 Black 2 (RX in)

Comms ground 5 Blue 5 (Ground)

4 (DTR), 8 (CTS), 6

(DSR)

Linked together
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The analogue output signal has a full scale range of 0 - 2.5 volts and an output

impedance of approximately 500 Ω .

The full scale output voltage is proportional to the full scale indication of the

active range. For example, if the active range is 0 - 25 mg/m
3
, an output

signal of 2.5 volts will represent a dust concentration of 25 mg/m
3
, (i.e. 1 mV

per 0.01 mg/ m
3
).

The analogue output is available only when a fixed measurement range is

selected (i.e. not Auto Range).

1.5 Schedule of Parts

MicroDust pro Control unit

MicroDust pro Probe

Calibration Filter

Carry Case

RS 232 Lead and Software

User Manual

4 x NiCad Rechargeable Batteries

12 V Power Supply with:

Mains Plug - UK Fitting

Mains Plug - European Fitting

Mains Plug - USA Fitting,

Mains Plug - Australian Fitting.

Figure 6 shows how the relevant plug adaptor for different local areas is fitted

to the power supply unit.

Figure 7 shows the components of the kit installed in the carry case.
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Figure 6: Fitting plug adaptor

Figure 7: The MicroDust pro installed in the carry case
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Page 12 of 60

Description MICRODUST pro Aerosol Monitoring System &

WINDUST pro Application Software - Handbook



2. OPERATION

The MicroDust pro is a sensitive scientific instrument which should not be

exposed to excessive moisture, vibration, or physical shocks.

The following steps must be performed before your MicroDust pro can be

used under operating conditions. It is suggested that you follow the

sequence of sections in this chapter.

For optimum accuracy, it is recommended that you always perform a user

calibration to correct your instrument for the type of dust to be measured.

2.1 Preparation for Use

2.1.1 Power Supply

The MicroDust pro is powered by

four AA size batteries located in a

compartment in the underside of

the instrument.

The instrument can also be

powered continuously using

external power applied via the

12 V DC socket (Figure 8),

without the need for internal

batteries to be installed.

To gain access to the batteries,

lift the bottom end of the cover

slightly to release it, then slide

downwards in the direction of the

arrow mark (Figure 9).

Warning !

One cell installed with the

wrong polarity may still

allow operation, but can

cause overheating severe

enough to rupture a cell

and damage the instrument.

Load four new batteries (AA or equivalent) in the orientations shown in

Figure 10. Rechargeable nickel-cadmium (NiCd) 1.2 V batteries are recom-

mended. 1.5 volt alkaline and other non-rechargeable batteries can also be

used.

Figure 8: Bottom panel connectors

Figure 9: Removing battery cover

00013

12 V DC
Power

RS 232

ClipTripod Bush

IrDA (Not
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Lift End
o
Release
Cover

Slide Off

00021

00015

Figure 10: Loading batteries
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Rechargeable batteries may be supplied by Casella CEL in a discharged state.

In order to obtain maximum capacity from new NiCd batteries, several charge

and discharge cycles may be required.

Serial Number Label

Boot Mode
Normally
Disabled

Charger
Enable

Factory
Settings

00014

O
N1

2

Figure 11: Location of DIP switches

Warning !

DO NOT enable the charger circuit while non-rechargeable

batteries are installed.

The instrument has a built in

fast-charging circuit that uses

power applied via the 12 V DC

socket shown in Figure 8. This

allows rechargeable batteries to

be recharged in-situ. When

rechargeable batteries are to be

charged in situ, set the Charger

Enable DIP switch to ON as

shown in Figure 11.

Charging will terminate automatically once the batteries are fully charged,

which takes approxi- mately 3 hours for fully discharged batteries.

2.1.2 Sampling Probe*

The detachable probe houses the measurement chamber together with the

associated optics, infra red emitter and receiver. Connect the probe by

inserting the cable connector into the socket in the top end of the instrument

case, with the red dot facing the front of the instrument to ensure correct pin

location.

DO NOT pull on the cable to disconnect the probe.

Disconnect the probe and cable from the instrument ONLY by pulling out-

wards on the knurled sleeve, in the direction of the arrows shown in Figure 4.

The probe may be un-clipped from the control unit for hand held operation.

2.1.3 Supporting the Instrument

For general monitoring applications the instrument may be fitted to a suitable

tripod (available from Casella CEL).

Note*: Reading errors may be observed when using the instrument in very bright

or changing ambient light conditions because the measurement method

depends on the scattering of infra-red light. Therefore, exercise care when

using in direct sunlight. Shield the probe from direct light sources and hold

it steady while taking a reading. An aspirated or PUFF adaptor may be used

to minimise light ingress.
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2.2 Preliminary Operations

2.2.1 Switching ON and OFF

1. Press to switch your MicroDust pro ON.

A welcome screen will be displayed showing the instrument�s name.

When switched ON the readings may drift a small amount, so allow

1 minute for the instrument to warm up.

2. Before proceeding with measurement, it is recommended that you

check that the zero and span (sensitivity) are correctly set and apply

a calibration for the type of dust to be measured. These checks and

calibrations are described in Section 2.3.

(Press for a shortcut to Calibration.)

3. Press to reset the Maximum (Max) and Average (Ave) levels.

4. Press or to display a profile graph of the current dust

concentration.

This graph scrolls across the screen from right to left as samples are

collected, with the current value shown at the right hand axis.

5. Press or again to return to the measurement display.

6. Press for about two seconds to switch your MicroDust pro OFF.

Ø.Ø26
Ave
Ma x

mg/m
3

Ø .ØØ6
1 .8Ø6

Ca l : - D E FAULT M
P

02

Indicates active keys

Battery icon that empties as

power is drained

Enter

3.0

0.00

1 .81Ø mg/m 3 1ØØsec M
P

03

Graph time base, change

between 100, 200 sec,15,

60 min, by pressing

Current value
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2.2.2 Checking Battery Status & Firmware Version

The internal battery voltage is displayed on the Status menu, together with

the instrument firmware (internal program) version.

1. Switch the instrument ON and wait for the measurement screen to

be displayed, as described in Section 2.2.

2. Press to display the Main menu.

3. Use or to highlight the MicroDust Status option.

4. Press to display the Status screen.

When the indicated voltage is greater than 4.8 V, the batteries are in

a fully charged condition. If the voltage from rechargeable batteries is

lower than 4.2 V, more than 80% of the capacity has been used.

Consider Recharging !

The battery icon will blink to warn that the internal battery is

approaching discharge. When the batteries become discharged,

logging is terminated and the instrument will commence an

automatic shut down sequence.

2.2.3 Configuring for the Current Measurement

The Configuration menu enables all functions for the instrument�s current

operating mode to be defined.

1. With the Main menu on display (see Section 2.2.2), use or to

highlight the Configuration option.

Esc

**MA IN MENU**
V i ew G r a phV i ew G r a ph
V i ew Measu r emen t
M i c r oDu s t S t a t u s
L o g g e r
Ca l i b r a t i o n
Con f i g u r a t i o n M

P
04

Enter

14 , Ma r ØØ 1Ø .25
Ba t t e r y : 4 . 9 Vo l t s
Memo r y : 2% Fu l l
R u n s : 1/32
Ve r s i o n : NN -NN -N
Use r : Name and

De t a i l s M
P

05

Ignore the displayed voltage

when external power is being

used
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2. Press to display the Configuration menu.

3. Specify the user language by pressing while highlighting the

Language option.

The following languages are available:

English,

Française,

Deutsch,

Italiano,

Español.

4. Use or to highlight the required language.

5. Press to select the language and return to the Configuration

screen.

6. Specify the measurement range by pressing while highlighting

the Measuring Range option.

The Dust Input Range screen is displayed.

The MicroDust pro has four measurement ranges (0 - 2.500, 0 - 25.00,

0 - 250.0 and 0 - 2500 mg/m
3
) plus an Auto Range setting.

It also has two graph settings:

Range Locked Locks the Y-axis limits to the

measurement range setting,

Auto Scale The Y-axis is auto-scaled to accommodate

only the range between the current

maximum and minimum measurements.

7. Use or to select the Range option.

8. Use or to select a range suitable for the anticipated dust

concentration, or set the instrument on Auto Range.

Enter

CONF I GURAT I ON
Measu r i n g Rang e
Av e r a g i n g T ime
Bac k L i g h t
T ime & Da t e
L a n g u a g e
Se r i a l C omm 's M

P
12

Enter

Enter

Enter
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The Auto Range setting is suitable for the vast majority of sampling

applications.

9. Use to move to the Graph option.

10. Use or to select a graph setting suitable for the anticipated

measurements.

11. Press to accept the settings and return to the Configuration

menu.

12. Specify the averaging time and analogue output parameters by

pressing while highlighting the Averaging Time option.

The Averaging Time screen is displayed.

13. Set the averaging time.

14 Use or to select Averaging Time, and or to edit the

entry.

The averaging time may be set in 1 second steps anywhere between

1 and 60 seconds.

The displayed dust concentration will then represent a rolling average

taken over the specified time.

In some measurement applications where aerosol concentrations

change rapidly, a longer averaging time will offer increased stability

for the displayed value.

15. Select an analogue output data type (optional).

16. Use or to select Analogue, and or to edit the entries.

17. Choose from the following options.

Raw: The analogue output is taken directly from

the signal conditioning circuit and is

normalised to match the range of the

instrument.

Enter

Enter

AVERAG ING T IME
Av e r a g e : 1 Se c

Av e
Ø f f
Ø . 5ØØ
Ke y p a d

Ana l o g u e :
A l a rm S t a t u s :
A l a rm Le v e l :
A l a rm Rese t :

M
P

30

Early firmware showed only

the Average field.

Since Version 06, more fields

have been displayed.
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Fast response shows sudden changes in

dust concentration.

Average: The analogue output is derived from the

averaging time set in the instrument and

provides a smoother instrument response.

Alarm: The output voltage will represent a set

digital value where 2.5 V is Alarm On and

0 V is Alarm Off.

When Alarm is selected, the following additional options come into

operation.

Status: On enables the alarm,

Off disables the alarm.

Alarm Level: Allows an alarm trigger level be set as

xxx.xx (mg/m
3
or mg/l). This mass

concentration level is taken from the

average reading selected in this menu.

When the concentration level is equal to

or greater than the alarm level, the alarm

is triggered instantaneously.

Alarm Reset: Auto resets the alarm when the

concentration level has fallen below the

alarm level for more the 5 seconds.

Keypad resets the alarm when any key is

pressed.

18. When all required settings for the proposed task have been selected,

press to accept them and return to the Configuration menu.

19. Specify the display back light function by pressing while high-

lighting the Back Light option.

20. Choose from the following options:

Light ON The display is lit as you leave this screen.

It remains lit until switched off.

Light OFF Switches the backlight off.

Keypress ON The display is lit each time a key is

pressed while viewing a menu.

It remains lit for the duration set.

Duration Sets the duration timer.

The duration may be set in 1 second steps anywhere between 5 and

30 seconds.

21. Press to accept the setting and return to the Configuration menu.

Enter

Enter

Enter
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22. Specify the time and date by pressing while highlighting the

Time & Date option.

The instrument has an internal real-time clock, which should be set

to the current time and date. When data is being logged, the dust

concentrations will be recorded against the current date and time.

When the instrument is configured by WinDust pro PC software, the

time and date on the internal clock are set automatically to the PC�s

time and date. Please refer to Chapter 3 for details.

23. Use or to select Set Time or Set Date.

24. Press to display the Set Time or Set Date screens.

25. Use or to select a time or date field to be edited and or

to edit the entry in the selected field.

26. Use or to select other date or time fields and or to edit

the entries.

27. When all entries on the time or date screen are correct, press to

accept the settings and return to the Time & Date screen.

28. Specify the serial communication details by pressing while

highlighting the Serial Comm�s option on the Configuration menu.

The Serial Port screen is displayed.

29. Use or to select Port or Baud Rate, and or to edit the

entry in the selected field.

Enter

Enter

SET T IME

Hou r s :
M i n u t e s : Ø1
Second s : 32

15
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SET DATE

Da t e :
Da y :

Mon t h : Ma r c h
Yea r : ØØ
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30. When the entries match the requirements of your PC (also see

Section 3.3.1), press to accept the settings.

2.3 Calibration

Before making any dust measurements, it is necessary to confirm that the

instrument is correctly zeroed and that its span control (sensitivity) is correctly

adjusted.

For optimum accuracy, it is recommended that you also perform a user

calibration to correct your instrument for the type of dust to be measured.

2.3.1 Checking Zero and Span

1. Select the Calibration option from the Main menu.

2. Display the Calibration menu. The calibration menu can also be

displayed by pressing while viewing the measurement screen.

When the instrument is to be calibrated for a specific type of dust

and/or a correction factor applied to the measured readings, refer to

Section 2.3.2.

3. Select the Set Zero option.

For sensitive measurements that will use the 0 - 2.5 or 0 - 25 mg/m
3

ranges, it is important to purge the probe with clean air prior to

checking or performing any zero adjustments. Fine dust particles in

the probe assembly may never settle, even with the probe collar

covering the inlet chamber.

4. Slide the probe collar over the inlet to the measurement chamber,

leaving only a small hole from which the purge air can vent.

5. Attach the purge bellows (supplied) to the probe purge inlet (shown

in Figure 12) and rapidly squeeze the bulb 5 or 6 times.

This action will inject clean air into the chamber, and remove possible

contamination which may have settled on the surface of optical

components within the probe. The user will probably see the

indicated concentration increase and then decrease towards zero.

Enter

CAL I BRAT I ON
Se t Z e r o
Se t S p an
Se t Op t i c a l F i l t e r
U s e r Du s t Ty p e s
Re s t o r e De f a u l t CAL
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6. Allow a few seconds for auto-ranging and for the reading to stabilise.

If the reading does not stabilise, rapidly squeeze the bulb a further

5 or 6 times and try again.

7. Once the reading is stable, press .

The instrument will now set the reading to zero, ±1 digit.

If the reading is not within ±1 digit of zero, wait a few seconds then

press again until it is.

When it is not possible for the instrument to zero itself on the

0 - 2.5 mg/m
3
range, a �Contamination Warning� message will be

displayed and a higher range selected. The 0 - 25 mg/m
3
range will

then become the lowest useable range until the probe is cleaned.

However, for accuracy and stability it is recommended that factory

cleaning take place.

8. Once the instrument has been set to zero, ensure that the rubber cap

is re-fitted to the purge inlet.

9. Select Set Span from the Calibration menu, so that the factory

calibrated span can be checked.

The basic span (or sensitivity*) of the instrument and probe is set

at the factory using ISO (Fine 12103-1 A2) calibration dust.

Enter

Enter

Note*: All light scattering instruments can have some sensitivity to a particulate�s

refractive index, size, shape and colour. The MicroDust pro uses a narrow

forward scattering angle to minimise these effects, but for optimum

calibration to a specific dust type, gravimetric calibration may be required.

This is described under calibration for a specific dust type in Section 2.3.2.

Purge Bellows

Calibration

Filter

00023

Figure 12: Inserting the Calibration Filter
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Each probe is supplied with its own calibration filter that creates a

fixed optical scattering effect within the sampling space. This fixed

reference can be used to confirm the factory calibration point for the

instrument and probe.

Use only the optical filter supplied for use with the probe.

The reference value for the calibration filter supplied for the probe is

shown on the filter and is also displayed at the bottom of the Set

Span screen.

10. Insert the calibration filter into the measurement chamber with the

arrow pointing towards the probe handle.

11. Press and wait a few seconds for the reading to stabilise.

The display should give a reading within ±1 digit of the value shown

on the calibration filter to confirm that the factory set sensitivity of

the instrument has not been changed.

12. If the correct value is not displayed (for example because the instru-

ment was last used with a different probe and filter) display the Set

Optical Filter screen.

13. Press and edit the entries to match the information given on the

filter.

14. Press to accept the changes.

This is an absolute calibration of the instrument that remains valid

when a correction factor is applied. After calibration, if the probe

becomes heavily contaminated, a warning will be displayed and the

contaminated ranges disabled.

2.3.2 Calibrating for a Specific Dust Type

All light scattering instruments exhibit some sensitivity to a particulate�s

refractive index, size, shape and colour. When faced with varying dust types,

the sensitivity of the instrument will differ slightly due to variations in

particulate size, refractive index and colour. The MicroDust pro�s use of a

narrow forward scattering angle minimises these effects but for optimum

calibration to a specific dust type, gravimetric calibration may be required.

The optional gravimetric and respirable adapters incorporate 25 or 37 mm

filter cassettes and provide a convenient method of gravimetrically calibrating

MicroDust pro instruments. Standard gravimetric techniques can be used

with the modules to give a cross check between the readings of the

MicroDust pro and a weighed sample. This is achieved by collecting two

Enter

Enter

Enter
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averages over the exposure period, one from the filter and the other provided

by the averaging function of the instrument. If differences are found between

the instrument�s reading and the gravimetric value, a user defined correction

factor can be loaded into the instrument for the dust type. This correction can

be applied automatically to any measured values to give optimum accuracy.

During the calibration run, it is necessary to determine the average real time

dust concentration which has been measured by the instrument. The internal

logger makes the recording and analysis of this data a simple task.

Use the following procedure to calibrate for a specific dust type.

1. Perform the Set Zero operation and confirm that the Span is set to

the factory calibration point (Section 2.3.1).

This returns the instrument to the default calibration set by the

factory so that all user defined calibrations are relative to this setting.

This is an absolute calibration that is not affected by changes to the

correction factor.

2. Fit the Gravimetric or Respirable adapter on to the probe and load a

pre-weighed filter into the cassette holder.

3. Adjust the sampling pump to provide the appropriate flow rate.

The respirable adapter requires a flow rate of 2.2 l/min.

For isokinetic sampling, pump flow rate is calculated from the sample

velocity and cross sectional area of the gravimetric inlet tube (2 cm
2
).

For general TSP measurements, actual flow rate is not critical but will

affect the mass of the collected sample.

4. Start gravimetric sampling and the internal logger (Section 2.5.3).

This resets the Average (T.W.A) value.

5. Continue sampling for a period long enough to allow the collection of

sufficient sample mass.

6. At the end of this sampling period, stop the data logger and sampling

pump.

The average real time reading is available from the display and will be

stored in the data file for the run.

7. Note the Average (T.W.A) value.

8. The filter should be conditioned and re-weighed to establish the

collected mass.

9. The gravimetric density during the sampling period can be established

by dividing the mass increase by the total volume sampled.
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The calibration correction factor is calculated as:

Example:

Filter mass increase = 3.21 mg

Volume Sampled = 0.75 m
3
(based on flow rate

and sample time)

Gravimetric density = 3.21 / 0.75 = 4.28 mg/m
3

T.W.A indication over period = 3.45 mg/m
3

(i.e. the instrument reads low)

Correction factor = 4.28 / 3.45 = 1.24

This correction factor can also be calculated automatically using the

WinDust pro software. (See Section 3.7).

2.3.3 Applying the Calibration

1. Check the zero and span settings as described in Section 2.3.1.

2. Select the User Dust Types option from the Calibration menu.

A list of the current dust types is displayed, with the active type

marked √.

The default dust type is a factory calibration that cannot be edited or

deleted. It is based on measurements using ISO Fine 12103-1 A2

(equivalent to Arizona Road Dust).

3. Move to an existing dust name (not Default) or to an empty space.

4. Press to step through the following options:

�√� The active dust type,

�del� Deletes this dust type,

�set� Sets a name and correction factor,

� � This type stored but inactive.

CorrectionFactor
GravimetricConcentration

Instrument Average ading T W A
=

Re ( . . )

Dus t Name OPT
Ø ] DE FAULT
1 ] L IMESTONE
2 ] S I T E 4
3 ] S I T E 5
4 ] ROAD STONE

√
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5. Select �set� and press .

6. Select Set Name and press .

7. Edit the name, then press to store the new name and return to

the Set Dust Parameters screen.

8. Select Set Factor and press .

9. Set the correction factor according to your calculation (Section 2.3.2).

10. When the instrument is used to measure this particular type of dust,

load the appropriate type from the Dust Name screen so that the

correction factor is applied automatically to the measured values.

2.4 Measurement

Before carrying out measurement, check the zero and span as described in

Section 2.3.1, calculate and apply a dust correction (Sections 2.3.2 and 2.3.3)

and select an Averaging Time and Range appropriate to the monitoring

application (Section 2.2.3).

With the measurement chamber aperture exposed, slowly move the probe

through the aerosol or rely on natural air movement. Measurements can be

taken with the probe either clipped to or unclipped from the display unit. For

static monitoring applications the use of an aspirator system is preferred

(refer to the Sampling Accessories sections in Chapter 4).

Any dust deposited on the surface of optical components should be blown

clear. To prolong the serviceable life of the instrument, it is recommended

that this operation be performed before and after each use.

In addition to the basic real time dust indication, the MicroDust pro is able to

calculate and display other useful data values as follows.

2.4.1 Maximum Value (Max.)

This value represents the maximum dust concentration that has occurred in

any one second period since the instrument was switched ON, reset

Enter

SET DUST PARAMETERS
Dus t : S I T E 4
Fa c t o r : 1 .ØØØ

Se t F a c t o r :
S e t Name :
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manually by pressing or logging started. The maximum value cannot be

reset while the logger is active.

2.4.2 Time Weighted Average Value (Ave)

The time weighted average value represents the running average dust

concentration since the instrument was switched ON, reset manually by

pressing or logging started. The average value cannot be reset while the

logger is active.

2.5 Data Logging

2.5.1 Configuring the Logger

Before storing data, the logger should be configured for the proposed

measurements.

1. From the Logger menu, select and display the Config Logger screen.

2. Select logger Interval.

The logger interval is the time between each recorded data point.

Intervals can be set between 1 and 600 seconds.

3. If necessary, change the current setting.

4. Select logger Mode.

The logger mode determines what happens when all empty memory

locations have been filled with data.

5. If necessary, change the setting to one of the following alternatives:

Overwrite RUN The logger simply carries on recording

data so that the oldest records will be

overwritten by new ones.

Stop When Full The logger stops logging when the

memory is full.

M
P

07

CONF I G LOGGER

I n t e r v a l s : S e cØØ1

S t o p when f u l l
C l e a r Memo r y : NO

Log t ime :
Mode :

ØØØ ,Ø4 :18 :15

Logging time available

(depends upon the intervals

set).
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2.5.2 Clearing the Logger Memory

The MicroDust pro has a logging capacity of over 15,700 data points and 32

runs, with the total number of stored runs shown on the Status screen.

When there is not sufficient space remaining in the instrument store for the

projected logging run, stored data can be deleted. All recorded data should be

downloaded before clearing the logger�s memory as there are no facilities to

recover data deleted from the instrument.

1. Select and display the Config Logger screen (see Section 2.5.1).

2. Highlight the Clear Memory option, select YES then press .

A warning message will be displayed asking for confirmation before

the contents of the memory are erased.

3. Press to confirm the erase operation.

ALL stored runs will be DELETED.

2.5.3 Start Logging

1. With the logger settings configured as described in Section 2.5.1,

(and the memory cleared when necessary) display the Logger screen.

2. Highlight the Start Logger option and press to start logging.

A measurement screen will be displayed showing the current dust

concentration. and can be pressed to switch between the

measurement screen and a graphical representation of the

concentration.

Enter

Enter

LOGGER

V i ew Run s
Con f i g L o g g e r

S t a r t L o g g e r

M
P
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mg/m
3
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Both screens identify the run and show the current interval number.

Data stored during the current (or other runs) can be reviewed on the

instrument display while it is being collected.

4. From the Logger screen, select and display the View Runs screen.

A summary screen for the earliest stored run will be displayed.

5. Use or to select summaries from other runs.

The run number and total of runs will be indicated. The current run

will also be available.

6. When sufficient data has been collected, stop logging by returning to

the Logger screen and using the Stop Logger option.

Logging stops and data up to the last completed interval is saved.

Each saved record contains the average concentration during the

logging interval, together with the date and time when it was saved.

At the end of each logging run (i.e. when logging is stopped or the

instrument switched off) a summary record will also be saved.

This identifies the average and maximum concentrations that have

occurred during the entire run. The time and date of the maximum

concentration are also saved.

Stored data can be downloaded for further manipulation and reporting

only by using WinDust pro Application Software.

T ime :
S t a r t Da t e :

16 :1Ø :57
Ø8 Ma r ØØ
Ø1/Ø2Run Numbe r :

Du r a t i o n : Ø1 :29 :44
Av e Va l u e :
Ma x Va l u e : 25 .ØØ

4 .37

M
P
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3. WINDUST pro APPLICATION SOFTWARE

WinDust pro Application Software supports the data logger facilities offered

by the MicroDust pro. It is specifically written by Casella CEL to simplify the

process of instrument configuration, downloading and data presentation.

Applications

¤ Monitoring respirable dust levels

¤ Work place monitoring

¤ Process monitoring

¤ Walk through survey

¤ Evaluation of filtration equipment performance

¤ Ambient air quality

¤ Detection of total dust emissions

¤ Indoor air pollution monitoring

The application, supplied on two 1.4 MB 3
1
/2� floppy disks, is designed to

operate within the 32 bit environment of Windows 95 and later or Windows

NT 4 and later.

The instrument communicates with the PC using an RS 232 serial port.

3.1 Installation on Windows 95™, 98™, ME™,
Windows NT™ & Windows 2000™

System Requirements:

IBM
TM

compatible PC with Pentium or better processor,

At least 8 MB of free RAM space,

Microsoft Windows 95/98/ME/NT, Windows 2000,

Hard drive with at least 4 MB of free space,

RS 232 Serial Communication Port,

3
1
/2� high density (1.4 MB) floppy disk drive for program installation,

Super VGA colour monitor,

Printer - optional.

Before installation, it is recommended that a back-up copy be made of the

program disks. Keep the originals in a safe place and use the copy to install

the software. The Setup program for WinDust pro will install files in the

specified Program directory and also in the Windows\System directory.

1. Start Windows.

2. Insert WinDust pro Disk 1 into the floppy disk drive.

3. Select Start from the task bar, then Run…
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4. Type a:\setup, where �a� identifies the floppy disk drive, then press

Enter.

5. Wait for the Casella CEL welcome screen to be displayed, then

follow the on-screen instructions.

Once installation is complete, a WinDust pro icon

will be found on your Windows desktop.

3.2 Starting WinDust pro

Start WinDust pro by double clicking on its desktop icon, or selecting it from

the Start Menu. The top level window will be displayed.

As the cursor is moved to each menu button, the relevant function will be

displayed on the message line at the bottom left of the display.

If this is the first time that you open the newly installed software, a dialog will

be displayed telling you that no profile has been defined and asking you to

create and select one before proceeding. Your only option is to click OK,

which displays the Active Profile dialog, (see Section 3.3.1).

3.3 Profiles

Profiles are used to identify the unique operating parameters of each

instrument or measurement application.

In situations where multiple instruments are interrogated by one PC, the use

of profiles provides a convenient way of identifying and managing data from

each instrument. Profiles are stored in the PC.

3.3.1 Creating/Editing a Profile

1. Create a new profile by selecting the Profiles option on the Edit

menu, or by clicking .

You will be presented with the Active Profile dialog where the active

profile is highlighted.

2. Select New or Edit as appropriate.

3. Enter a suitable name in the Profile Name dialog for a new profile, or

select an existing name.

Three tab Properties dialogs define the basic features of the profile.

The Instrument dialog specifies instrument type, date format, ID

and selects a pre-drawn 128 wide by 64 high, black and white bitmap

(.bmp) for use as a welcome screen
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4. Make sure that instrument type Pro is selected.

5. Make suitable entries in the other fields.

In addition to normal alpha-numeric characters, the following may

also be used in the messages, � + - : ( ) + - # and SPACE�.

The Communications dialog configures the RS 232 serial interface

and specifies Modem details. See Figure 13.

6. Make entries in the Comms fields to suit the PC and communications

port in use.

Default settings for a MicroDust pro are shown, so that only the

Port may need to be defined. If a mouse or other device is already

installed on Com1, then change the entry to another free port.

7. When a modem connection is to be used, select Comms via a
modem and make entries in the Modem fields to suit the modem in

use.

The default settings match those of typical modems, so the only

parameter that must be entered is the phone number at Dial.

Figure 13: The Communications dialog
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The Data Files dialog specifies a file prefix and store location for the

data files to be downloaded.

As the instrument may contain data from many different sampling

runs, the downloaded data will be split into individual files, each one

representing a single run.

The File Prefix defines the first six characters of the file name for

downloaded data. You may want to add a hyphen (as shown below),

to separate the date from the prefix. The last two digits are a unique

number allocated automatically as each series of runs is downloaded.

For example, if the data directory already has files identified as:

Factory-08-02-00-01.DAT

Factory-08-02-00-02.DAT

and the instrument contains two sampling runs, after downloading

the files will have been added to the end of the list as follows.

Factory-08-02-00-01.DAT

Factory-08-02-00-02.DAT

Factory-08-02-00-03.DAT

Factory-08-02-00-04.DAT.

A warning will be given if the software detects that more than 99 files

with the current prefix are to be downloaded. If this occurs, define a

new file prefix before commencing download.

8. Make a suitable entry.

9. When the default directory is not suitable, select a file path and

directory for storing data files.

10. Click OK to save the information in the profile.

11. Accept this as the active profile.

3.3.2 Sending a Profile to the Instrument

The configuration information contained in an instrument profile must be

transferred to the MicroDust pro . Before attempting to send a profile, make

sure the instrument is switched on and the serial communications cable

plugged into both the instrument and the appropriate port on your PC.

1. Select Send Profile from the Comms menu, or click .

A message will be displayed, warning that this procedure will erase

all data in the instrument and asking if you want to continue.

2. Start the transfer.
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Any errors will be reported and the transfer aborted.

During the transfer, the instrument�s internal clock will be reset using

the date and time from the PC. (Ensure the PC�s clock is correctly

set !)

3.4 Downloading Data from the Logger

Before you can generate graphs and tables from the data recorded by your

MicroDust pro, you must download it to your PC.

1. Make sure the instrument is switched on and the communications

cable plugged into both the MicroDust and the appropriate serial port

on your computer.

2. To start downloading, select Download from the Comms menu, or

click .

The download sequence can be followed on the PC screen.

Data from individual sample runs will be saved in separate files with

each file being allocated a unique index number. (See Section 3.3.1.)

3.5 Presentation of Data

Three data presentation options are available: summary, graph and table.

When data is displayed using any of these options, use Print from the File

menu, or click to print a hard copy of the current information or graph on

a printer attached on-line to your PC. The File menu offers Print Preview
which allows you to check how the printed material will appear on the page.

Use Copy from the Edit menu, or click to copy the current information

or graph to your PC clipboard, from where it may be pasted into other

applications. Data files that contain more than approximately 500 records may

be too large to be copied in this way. Therefore when they contain more than

500 records, it is recommended that they be imported using external

software such as Microsoft� Excel or Word. See Section 3.5.4.

The font used to display the summary, graph scales and table can be

modified by selecting Font from the Edit menu to obtain a Font selection

dialog.

3.5.1 Displaying the Data Summary

Before reviewing a data file stored on the PC, you must open it as follows.
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1. Select Open from the File menu, or click .

A dialog will be displayed that allows you to select the data file to be

opened.

2. Select and open the required data.

The data summary will be displayed. This is the starting point for

accessing all analysis displays available within the WinDust pro

software.

It shows maximum and minimum dust concentrations, the dates and

times when they occurred and the average concentration during the

whole run. See Figure 14.

Once the file is active, graph and table displays can be opened.

2. At any time, the Summary screen can be recalled to the display by

selecting Summary from the View menu or by clicking .

Figure 14: The Summary window
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3.5.2 Displaying Data as a Graph

1. Open the file you want to display as a graph, as described in

Section 3.5.1.

2. Select Graph from the View menu or click .

The graph will be displayed as shown in Figure 15. Both axes of the

graph are scaled automatically to cover the full range of dust

concentrations stored and the entire time period contained in the

data file.

3. To enlarge a section of the graph for closer inspection, position the

mouse pointer at the point on the time axis where you want the new

display to start.

4. Hold down the left mouse button while dragging to the right until

the highlighted portion covers the section of the graph you want to

expand.

Figure 15: The Graph window with a portion marked for expansion

Note: The peaks shown on the graph are averaged over the logging interval and

in consequence may be different from the maximum instantaneous value

shown in the corresponding summary.
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The graph is redrawn with the selected portion expanded to fill the

whole frame (shown in Figure 16).

3.5.3 Displaying Data as a Table

Displaying the information as a table allows you to see the actual values

stored, together with the date & time of their occurrence.

1. Open the file you want to display as a table, as described in

Section 3.5.1.

2. Select Table from the View menu or click .

A table that includes all of the records in the file will be displayed, as

shown in Figure 17.

3. Use the vertical scroll bar to move up and down within the table.

3.5.4 Exporting Data to Other Applications

Windust pro data files (.dat) can be imported into other applications.

Data files created by WinDust pro are saved as comma delimited ASCII text.

Each set of readings is saved as a single line terminated by a carriage return/

Figure 16: The expanded graph
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line feed pair. These files are easily imported into many commercial word

processor and spreadsheet applications such as Microsoft� Word and Excel.

3.6 Real-Time Display Mode

The WinDust pro application is able to provide a real time graphical display of

the MicroDust pro current reading. A scrolling real time graph provides a clear

indication of changes in dust concentration as they occur. Before using the

real time display facility, ensure that your MicroDust pro is switched on and

connected to the appropriate serial port of your PC.

1. Select Real Time from the Comms menu, or click .

The real time window will be displayed. A measurement profile for

the run will start immediately scrolling from the right, as shown in

Figure: 18.

2. The Summary area shows the maximum, average and minimum

concentration measurements (mg/m
3
) encountered during the

current run.

Press the Reset button to clear existing values.

Figure 17: The Table window
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3. The boxes on the Graph y-axis show the display range.

Click inside the boxes and type the desired values, then use the

Re-scale button to change this range.

The intermediate values will be adjusted automatically.

4. Use Auto Scale to allow the y-axis to accommodate the maximum

and minimum values.

It is suggested that you let the run progress long enough to encounter

typical maximum and minimum values before using Auto Scale.

5. Press one of the buttons in the Timebase area to select an x-axis time

base period of:

1 minute , 10 minutes, 1 hour, or 5 hours.

3.7 Gravimetric Correction by WinDust pro
Software

Data files stored by the PC may be automatically scaled and correlated to a

gravimetric filter result. This ensures optimum calibration to suit local

measurement conditions (Particle size, shape and chemical composition).

Figure 18: The Real-Time window
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The gravimetric correction function automatically compares a true gravimetric

concentration of dust with the corresponding data stored in the PC date file.

1. Load the relevant data file, as described in Section 3.5, ensuring that

it corresponds with the gravimetric result.

The data summary will be displayed.

2. Select Calibration from the Edit menu or click .

A dialog will be opened.

If the file has already been corrected for gravimetric results, a warning

will be given. (To remove an existing correction refer to Step 7.)

3. Enter the gravimetric filter result in the Gravimetric Sample field (i.e.

the gravimetric density determined as in Section 2.3.2).

4. When required, enter information in the relevant field to identify the

calibration for the file.

5. Select OK to proceed.

The software compares the gravimetric result with the measured

average from the file and calculates a gravimetric correction factor.

When a graph or table is displayed for this file, the correction factor

will be applied automatically to the data so that corrected results are

displayed.

When the corrected graph or table is closed, you will be asked to

save the changes in the file.

6. If required, select Yes.

The modified file will be saved with the original file name and

extension (.dat).

7. If you want to remove any corrections applied to a datafile, activate

the correction function and enter �0" in the Gravimetric Sample field.

The existing corrections will be removed.
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4. SAMPLING ACCESSORIES

When used in static monitoring applications, the sampling probe�s

measurement chamber should have some form of aspiration, either in the

form of an Apex (or Vortex) sampling pump or a fan aspirator unit.

Maintaining airflow through the probe eliminates potential errors due to

orientation of the probe inlet and size selectivity.

The gravimetric and respirable adapters incorporate 25 or 37 mm filter

cassettes and provide a convenient method of gravimetrically calibrating

MicroDust pro instruments.

4.1 Gravimetric Adapters

The gravimetric adapter units may be used in conjunction with a sampling

pump to enable all sampled particulate matter to be drawn through the probe

measurement chamber and then deposited on to a 25 or 37 mm filter. There

are three gravimetric adapter options available.

Total Suspended Particulate (TSP)

All sampled particulate is monitored in real time and then deposited

on to a sample filter. The design provides no size selective

characteristics.

Respirable (4 µm)

The respirable adapter design incorporates a Cyclone size selective

unit. Only the respirable fraction of particulate passes through the

probe and is deposited on to the filter.

PUF (Polyurethane Foam Filter)

The PUF gravimetric adapter uses foam filter inserts to provide size

selective sampling characteristics. Filters are available for PM10,

Respirable (4 µm) and PM2.5 size fractions.

All components fit together using �O� rings for sealing. These should be

checked for signs of damage, which may result in erroneous readings due to

air leakage. The adapters enable standard gravimetric techniques to be used

and provide a cross check between the readings of the MicroDust pro and a

weighed sample.

If errors are found between the instruments reading and the gravimetric

value, a correction figure can be determined and applied to give a closer

correlation of the two readings. (Please refer to Calibrating for a Specific Dust

Type in Section 2.3.2.)

The sampling probe should be inserted into the adapter block and correctly

aligned over the sample inlet. The locating spigot of the Cyclone, TSP inlet

tube or PUF filter holder should be inserted into the probe�s sample inlet so

that the complete assembly cannot rotate or move laterally on the probe.
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4.2 TSP / Respirable Adapters

The basic design of the TSP and respirable adapters is the same, but with

different inlet fittings. The respirable adapter uses the Cyclone principle of

dust separation to draw only the respirable fraction of particulate matter

through the measurement chamber and on to the filter (D50 cut = 4 µm at

2.2 l/min).

The cyclone is fitted to the mounting block using an �O� ring seal. A suitable

constant flow pump set for 2.2 l/min such as the Casella Apex, Apex pro,

Vortex Standard 2, or Timer 2 should be connected to the filter cassette

assembly using silicone tubing.

The cyclone must operate in the upright position and the �coarse dust

container� (rubber grit pot) should be cleaned periodically and checked for

damage.

Pump Connection

ø37 mm Filter Holder

00026

"O" Ring

"O" Ring

Adapter

Locating Spigot

Inlet Tube Complete

"O" Ring

Thumb Screw

ø25 mm
Filter Holder

ø37 mm
to ø25 mm
Reducer

"O" Ring

Measuring Chamber
MicroDust Probe

"O" Ring

Coarse Dust
Container

Locating Spigot

Cyclone Complete

Figure 19: Arrangement of Gravimetric and Respirable adapter modules
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When mounting a filter in the clear plastic cassette assembly, ensure the

filter is held firmly against the filter support pad, a loose filter will give

incorrect results.

When the Cyclone is pressed into the mounting block, the Cyclone spigot

should locate in the probe so that the complete assembly cannot rotate or

move laterally on the probe. Secure in position using the thumb screw.

4.3 PUF Filter Adapter

The MicroDust polyurethane foam filter (PUF filter) adapter may be used for

PM10, respirable and PM2.5 sampling applications using a flow rate of

3.5 l/min. The design is based upon the Conical Inhalable Sampler (CIS)

identified in the Health and Safety Executives publication, MDHS14.

For monitoring applications the adapter is fitted to the MicroDust pro probe

as shown in Figure 20.

Pump Connection

00027

ø37 mm Filter Holder

"O" Ring
"O" Ring

Locating Spigot

PUF Filter Holder
PM /Respirable10

ø25 mm Filter Holder

"O"
Ring

MicroDust Probe

Measuring Chamber

Locating Spigot

PUF Filter Holder PM2.5

PUF Filter Head Cap

Adapter

ø37 mm to ø25 mm
Reducer

Figure 20: Installing the Adapter
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Sample air is drawn through the PUF filter and then into the MicroDust pro

measurement chamber before being deposited on to either a 25 or 37 mm

filter.

The type of foam filter loaded into the adapter determines the size of

particulate matter being monitored by the MicroDust pro and collected on the

filter.

Although the PUF foam inserts have been designed as size selective filters to

capture particles larger than a specified mean aerodynamic size, It is also

possible to pre/post weigh the PUF inserts to establish both the total

suspended particulate (TSP) value and the desired size fraction.

Storage of PUF Filters

PUF filters should be kept in a clean and preferably air-conditioned

environment.

Inserting / Removing PUF Filters

PUF filters should be carefully inserted or removed from their respective

cassettes using clean tweezers and plastic gloves. Avoid subjecting the filters

to physical damage, creasing or folding.

PUF Filter Spares List

PM2.5 foams (packet of 10) P118204

PM10 foams (packet of 10) P118206

Respirable 2 foams (packet of 10) P118208

4.4 Aspirator Unit

The fan driven aspirator unit may be used to draw all suspended particulate

matter through the probe provided no back pressure is present. The unit is

assembled as indicated in Figure 21.

The aspirator and inlet tube are a push fit in the mounting block. When

assembling the units together, care should be taken to prevent damage to

the �O� rings. The complete assembly is located and secured to the

measurement probe with the spigot of the inlet tube engaging into the

measurement chamber aperture.

A 5 V DC mains adapter unit or battery pack can be used to power the

aspirator fan.

The aspirator unit should be cleaned periodically to ensure that an

accumulation of dust does not result in erroneous readings or mechanical

seizure.
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Figure 21: The Aspirator Unit

Fan Aspirator

'O' Ring

'O' Ring

Adapter

Locating Spigot
'O' Ring

Inlet Tube Complete

Thumb ScrewMeasuring
Chamber

MicroDust
Probe

00024
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5. MAINTENANCE & SERVICING

5.1 Service Department

Casella CEL�s in house service department offers a comprehensive range of

repair and calibration services, designed to effect a fast and efficient back-up

for all our products. The Service Department is operated under the scope of

our BSI registration for products manufactured by us. We will however,

undertake the repair of other manufacturers equipment. For further

information please contact our service department at our Bedford

headquarters. We will be happy to provide quotations for individual repairs or

provide annual maintenance under contract.

We recommend factory service by technicians trained and equipped to repair

your instrumentation. Should you wish factory repair assistance, send your

equipment in a package equivalent to the original packaging. Insure to full

value and ship pre-paid. Include a letter giving full details with your packing

list.

Send to: Casella CEL Ltd

(Service Department)

Regent House

Wolseley Road

Kempston

Beds MK42 7JY

United Kingdom

For service outside the United Kingdom, please return to our appointed

distributor.

5.2 Lens Contamination

As with all optical dust measurement equipment, lenses may eventually

become contaminated with particulate that has settled on the surface. In the

long term, this can reduce the instrument�s reading for a given dust

concentration or cause difficulty in achieving a stable zero indication. By

careful design of the optics and measurement chamber, the need for regular

cleaning of the lenses has been greatly reduced.

5.2.1 Long Term Monitoring

For long term sampling or where high contamination levels are anticipated,

continuous purging by a source of dry filtered air is recommended. Use one

of the pumps from the Vortex series. The flow rate to the purge inlet should

be maintained at approximately 10% of the main sample rate.

When continuous purging is adopted, it is necessary to draw the aerosol

through the probe�s measurement chamber using an aspiration technique.
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If this is not done, the clean purge air emerging from the measurement

chamber will prevent entry of particulate matter.

5.2.2 Cleaning

When it is suspected that lens contamination has occurred (recognised by

the inability to zero or calibrate the instrument correctly), attach the air purge

bellows to the probe inlet and pump vigorously with the measurement

chamber open. Any dust deposited on the surface of optical components

should be blown clear.

To prolong the serviceable life of the instrument, it is recommended that this

operation be performed after each use.

If the lenses become so heavily contaminated that using the air purge pump

is ineffective, the instrument should be returned to Casella CEL for cleaning

and re-calibration. Note that the Warranty does not extend to cleaning or

general servicing of the instrument.

5.3 Fault Finding Tips

The MicroDust pro contains no user serviceable components. Repairs should

be performed only by authorised personnel.

If an electrical fault is found, or a fault persists after carrying

out the recommendations in the service hint, return the

instrument to Casella CEL Ltd for repair.

Fault Symptom Possible Cause Service Hint

Instrument does not
switch ON

Battery discharged, or
failing to charge. Confirm
charger indicator is lit

Recharge or replace
battery if necessary.
Use external power supply.

Probe always reads zero Fault with Infrared
transmitter or receiver.

Check the probe
connection.

Continuous �over range�
indication

Optical misalignment due
to mechanical shock.
Excessive contamination.

Return the instrument to
the service department for
optical alignment, cleaning
and re-calibration.

Unstable or drifting zero in-
dication with probe cover
on

Sample chamber may be
contaminated by dust or
fibre.

Use the bellows pump to
purge the probe with clean
air prior to setting zero.
The probe cover should be
open slightly when
purging, to allow venting of
purge air.

Probe contamination
message is displayed

Excessive contamination of
probe or optical
misalignment due to
mechanical shock.

Purge the probe with clean
air from the bellows pump.
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6. SPECIFICATION

6.1 Instrument Specification

Measurement

Sensing technique: Forward light scattering (12 to 20
o
) using

880 nm infra red source.

Measuring Range: 0.001 - 2,500 mg/m
3
over four ranges

0 - 2.5, 0 - 25, 0 - 250 and 0 - 2500 mg/m
3
.

Active range may be fixed or auto ranging.

Resolution: 0.001 mg/m
3
.

Zero stability: Typically <2 µg/ m3
/
o
C.

Span Stability: ±0.7% of reading /
o
C.

Operating Temp Range: 0 to 50
o
C (non condensing).

Storage Temp Range: -20 to +55
o
C (non condensing).

Power Supply

Instrument Power Consumption:

Approx. 100 mA.

Battery: 4 x AA / MN1500 cells Alkaline or

rechargeable Nickel Cadmium.

Operating run time: Alkaline Batteries (2700 mAh), typically

>20 hours,

Rechargeable NiCd cells (950 mAh),

typically >9 hours

Battery Charging Internal NiCd fast charger circuitry.

Charge termination based on Negative

delta V detection with additional time-out

protection.

Charger must be disabled for dry cell

operation.

Charge Rate Fast charge rate 450 mA,

Standby charge rate 55 mA approx.

Power adapter (-PC18) Universal with input voltage range

100 - 240 VAC, 47 - 63 Hz.

Output 12 VDC at 0.8 A.

Supplied with connectors suitable for

USA, UK, European and Australian mains

outlet sockets.

The instrument may be powered

continuously from the external power

adapter.
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Physical

Display: 128 x 64 pixel LCD Graphics panel with

backlight.

Keypad: 7 key tactile membrane

Weight: Instrument with probe: 0.97 kg.

Complete kit in carry case: 4.5 kg

Dimensions: Instrument H x W x D: 245 x 95 x 50 mm.

Probe: 35 mm ∅ x 290 mm total length.

Carrying case H x W x D: 135 x 490 x 370

mm.

Displayed Values

Current Concentration Represents the rolling average of instan-

taneous dust concentration over a user

selectable time period from 1 to 60 sec.

Time weighted average Representing the average value since

switch on or reset.

Max Value Representing the maximum instantaneous

value since switch on or reset.

(Instantaneous values are updated every

second)

Scrolling Graph Graph mode provides unique indication of

variations in dust concentration.

Selectable timebase periods of 100 sec,

200 sec, 15 mins, 60 mins,

Y-axis range may be autoranging or fixed.

Factory calibration Factory calibrated using traceable

isokinetic techniques and ISO 12103-1 A2

Fine test dust (Arizona Road Dust

equivalent).

Four user defined calibration settings to

suit specific dust types or monitoring

applications.

Routine Calibration Easy software calibration for Zero and

Span setting.

Confirmation of Factory calibration point

using optical reference filter.

Data Logger

Internal memory: 64 k EEPROM providing over 15,700 data

points.

Example capacities: Logging every 5 seconds: 21 hours

48 mins,

Logging every minute: 10 days 21 hours

Logger Interval: Adjustable from 2 to 600 seconds.
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Recorded Values: Average concentration over logging interval.

Maximum and Average values for the

entire logging period are saved at the end

of each logging run.

Serial Interface: RS232 up to 38,400 baud.

IrDa (Future expansion).

Analogue output: 0 - 2.5 V DC FSD, 500 Ω output

impedance.

Digital output (only when Alarm is selected):

2.5 V Alarm On,

0 V Alarm Off.

6.2 Maintenance

Factory cleaning required annually, depending on measurement conditions.

6.3 WinDust pro, PC Based Application Software

Provides a friendly graphical interface for instrument configuration, data

download and graphical report presentation.

Operating System M.S Windows 95/98/ME/2000 and

NT compatible,

Pentium or better processor,

Requires RS232 serial port,

8 MB RAM,

Hard drive with at least 4 MB free space,

3
1
/2� (1.4 MB) floppy disk drive,

VGA colour graphics,

Printer - optional.

6.4 Spare Parts

-B141 NiCad Rechargeable Battery (4 required).

6.5 Optional Accessories

176086B Car Charging Lead,

180043B 10 m Extension Cable.

6.6 CE Compliance

The MicroDust pro complies with the EMC Directive 89/336/EEC of the

European Union. It has been tested according to the standard delivery

schedule and complies with the following standards.
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EN 50081-1 : 1992, EN 50081-2 : 1993:

Generic emission standards for

residential, commercial, light industry and

industrial environments.

EN 50082-1 : 1992, EN 50082-2 : 1995:

Generic immunity standards (for both RF

fields and electrostatic discharge) for

residential, commercial, light industry and

industrial environments.

EN 61000-4-2 : 1995, IEC 61000-4-2 : 1995:

Electromagnetic compatability (EMC).

Testing and measurement techniques.

Electrostatic discharge immunity test.
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APPENDIX A
Microdust pro Remote Control Command Set

A.1 Introduction

The Casella Microdust pro Real Time Dust Monitor (RDM) can be remotely

controlled from a PC suitably equipped with a simple terminal emulation

program such as that found in many operating system software packages.

Connection between the PC and the RDM is achieved using the cable that

was originally supplied with each RDM when first delivered. Connect the

6-way mini DIN plug to the socket on the bottom of the RDM and the 9-way

plug into a convenient RS232 communication port on the rear of the PC. If a

special cable needs to be manufactured please consult Chapter 1 for details

of the pin assignments given in Figure 5 and Table 1.

Communication takes place with a variable Baud rate from 600 to 38400 bps,

8 data bits, 1 stop bit no parity over RS232 levels.

A number of single letter commands are given below to action key functions

while mimicking the action of the keypad buttons will allow the whole of the

instrument�s menu structure to be accessed as if the user was pressing the

keypad directly.

The following commands are described:

Command �B�: Upload bitmap screen to instrument

Command �C�: Clear bitmap

Command �I�: Interrogate target

Command �R�: Set instrument id and time date

Command �T�: Download records stored

Command �X�: Start real time output

Command �Z�: Stop real time output

Keypad User interface commands.

A.2 Individual Commands

Command ‘X’: - Start real time output

E.g. �X�

The instrument will transmit the average dust concentration displayed on the

instrument, and will be updated very second.

i.e. �2.87[CR][LF]�

�2.55[CR][LF]�

�2.60[CR][LF]� ; etc.
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Command ‘Z’: - Stop real time output

E.g. �Z� ; This will inhibit the real-time data output.

Command ‘I’: - Interrogate target

E.g. �I�

The instrument will transmit a comma-delimited string containing two ID

strings. The first is the number of records stored in the loggers and the

second is the firmware version of the instrument.

i.e. �CasellaCEL,(01234) 844100,K, 11,80-176087A-XX,[CR][LF]�

(This information can be viewed in the status screen of the instrument.)

Command ‘T’: - Download records stored

E.g. �T� ; Download all records stored in the instrument

i.e. Log close, 28/07/03,12:13:48, 129.396, 129.445,28/07/03,12:13:42,

0 [CR][LF]

28/07/03,12:13:48, 129.361, 1 [CR][LF]

28/07/03,12:13:46, 129.387, 2 [CR][LF]

28/07/03,12:13:44, 129.439, 3 [CR][LF]

Log close, 28/07/03,12:11:30, 240.920, 240.947,28/07/03,12:11:22,

4 [CR][LF]

28/07/03,12:11:30, 240.882, 5 [CR][LF]

28/07/03,12:11:28, 240.909, 6 [CR][LF]

28/07/03,12:11:26, 240.897, 7 [CR][LF]

28/07/03,12:11:24, 240.920, 8 [CR][LF]

28/07/03,12:11:22, 240.937, 9 [CR][LF]

28/07/03,12:11:20, 240.935, 10 [CR][LF]

28/07/03,12:11:18, 240.943, 11 [CR][LF]

28/07/03,12:11:16, 240.935, 12 [CR][LF]

Command ‘R’: - Set instrument id and time date

This command will enable the user to remotely set time/date and two ID

string. All records stored in the instrument will be erased.

(This information can be view in the status screen of the instrument).

E.g. �R� ; wait until �D� received then transmit data.

�CasellaCEL,(01234)844100,K,28/07/03,12:30[CR][LF]�

NOTE: ID max string length 16 bytes each. Date format is dd/mm/yy. Time

format is hh:mm in 24 hour format.
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Command ‘B’: - Upload bitmap screen to instrument

E.g. �B� ; wait until �D� received then transmit 1024 bytes.

First byte will form the top left column of the display.

Command ‘C’: - Clear bitmap

E.g. �C� ;To restore the start up bitmap to the default.

User interface Commands

Keypad of the Microdust Pro RDM

Display

�i� // Screen dump

The screen dump from the instrument should be requested not more rapidly

than once every two seconds to allow all the data to be transferred

successfully.

Data format is binary data and first byte is top left column of display.

MICRODUST pro
Aerosol Monitoring System

Esc

Enter

v03051

'e' Escape key

ON/OFF

'u' Up key

'l' Left key

'r' Right key

'd' Down key

0x0D Enter key
(same as return key)
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A l a rm Le v e l :
A l a rm Rese t :

14 , Ma r ØØ 1Ø .25
Ba t t e r y : 4 . 9 Vo l t s
Memo r y : 2% Fu l l
R u n s : 1/32
Ve r s i o n : NN -NN -N
Use r : Name and

De t a i l s

LOGGER

V i ew Run s
Con f i g L o g g e r

S t a r t L o g g e r E n a b l e : L i g h t , O F F

L o g t ime :
Mode :

ØØØ ,Ø4 :18 :15

*

*Op t i o n s i n t r o du c ed a t
F i rmwa r e Ve r s i o n 06 .

}

CAL I BRAT I ON
Se t Z e r o
Se t S p an
Se t Op t i c a l F i l t e r
U s e r Du s t Ty p e s
Re s t o r e De f a u l t CAL

WARN ING
P r e s s i n g L o a d s
b a s i c c a l i b r a t i o n
c o n s t a n t s .
U s e Op t i c a l f i l t e r
f o r O p t imum accu r a c y.

C a n c e l

S E T OPT I CAL F I LT ER

Se t v a l u e s h own on
Ca l i b r a t i o n f i l t e r

25.ØØ2

1ØØsec

2 12 15:Ø5:32
3.0

0.00

2 .Ø18 mg/m 3
Case l l a CEL L td


